ECDL Advanced 2.0 Section 5 Slide Shows

Section 5
Slide Shows

By the end of this Section you should be able to:

Create and Edit Action Buttons/Hyperlinks
Create and Edit Custom Shows

Run a Custom Show

Apply Slide Transitions

Apply Timings

Set up a Slide Show

Use Various Techniques while Running a Show

To gain an understanding of the above features, work through the Driving
Lessons in this Section.

For each Driving Lesson, read the Park and Read instructions, without
touching the keyboard, then work through the numbered steps of the

Manoeuvres on the computer. Complete the Revision Exercise(s) at the end of
the section to test your knowledge.
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Driving Lesson 39 - Action Buttons

M Park and Read

Action buttons can be added to allow rapid and easy navigation between
slides during the presentation using hyperlinks. Action buttons also allow
movement to other presentations, files, web sites and various other
destinations.

@ Manoeuvres

1.
2.

4.

Open the Training presentation and save it as Training?2.

Select slide 4, The Open Learning Guide.

To create an action button that links to slide 7, click the Shapes |_|_'
button on the Home tab, look in the Action Buttons section of }

the list and select the Information action button, D

Shapes

Click and drag the shape of the button on the bottom left side of the slide.

E If a message appears about saving the presentation, select Yes.

5.

The Action Settings dialog box appears. Ensure that the Mouse Click
tab is selected. Click the Hyperlink to option, scroll down the drop down
list and select Slide....

A list of slides in the presentation is displayed, select slide 7 Where to
Get More Information.

Hyperlink to Slide

Slide title
1. Training Needs Assessment
2. Introduction
3. Record of Achievement Matrix
4, The Open Learning Guide
5. Revision Exercises
B, Summary
7. Where to Get More Information

Click OK, and then OK to close the dialog box.

Click the Slide Show tab and select From Current Slide to see the slide
as it will appear in the presentation.

When the cursor appears, click the action button. The presentation moves
to the Where to Get More Information slide.

continued over
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10.

11.

12.

13.
14.

15.

16.

17.

18.

19.
20.
21.
22.

23.

Driving Lesson 39 - Continued

The presentation will continue from its new position (there is no automatic
return to the original slide). Click until the show is ended.

With slide 7 displayed in Normal View, draw a Custom action button, I:l
which will link to a separate presentation.

In the Action Settings dialog box, select Hyperlink to and then Other
PowerPoint Presentation.

Select CIA Seminar from the list.

Click OK and ensure Hyperlink to Slide shows Slide 1 highlighted and
then click OK.

Click OK to create the link and with the button selected type CiA so it is
labelled.

JGA;

View the slide show and test the button. Click to view the CIA show. End
the CIA show to return to the Training2 show.

Press <Esc> to end that show and return to Normal View.

At the bottom left of slide 5 draw a Document action button, . This will
link to a Word document.

From Action Settings select Hyperlink to then Other File.
Choose the Sample file and click OK then OK again.
Add the text Sample to the button. Enlarge the button if necessary.

Run the show and after the text has loaded click the Sample action
button. Word starts and opens the document. Close Word, without saving
if prompted and end the show.

Right click on the Sample button and select Edit Hyperlink. To remove
the hyperlink from an action button, select None from Action on click
and click OK.

E Alternatively, right click on the button and select Remove Hyperlink.

24.

Hyperlinks can also be applied to text or graphical objects - you don’t
always have to use action buttons. Display slide 7 and select the text
Information.

continued over
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Driving Lesson 39 - Continued

25. Display the Insert tab and click the Hyperlink button from the @
Links group. E5)

Hyperlink

26. Make sure Existing File or Web Page is selected on the left
and type www.ciatraining.co.uk in the Address box. PowerPoint adds
the necessary components to make this a valid web address.

Insert Hyperlink
Link to: Text to display: | Information
_.:'j Look in: . AM& PowerPoint 2007 Data IEI
Existing File or
Web Page ) abseiling.doct - Bookmark...
—— | | Curent @ Assessment.ppix =
_ Folder ) Bin B 3
§3 21 Big Bird.pptx
Place in This 57 Bridge.qif
Document Browsed |(E] Business.pptx

Pages 54 Butterfly.qif
& canyon.bmp

Create Mew Recent |38 cat.gif
Document Files & catlink.bmp
(B Chart Test.ppix -
\ Address: http: /fwww. diatraining. co.uk | E

E-mail Address

27. Click OK. The text Information is displayed in a different colour to
indicate it is a hyperlink.

28. Run the show from slide 7. Move the cursor over the Information text.
The cursor changes to a hand.

29. Click on the text. If an Internet connection exists, your browser application
will start and the CiA Training home page will be displayed.

30. Close the browser window and end the slide show.

E Hyperlinks can be removed from objects by right clicking and selecting
Remove Hyperlink.

31. Save the presentation and leave it open.
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Driving Lesson 40 - Editing an Action Button

M Park and Read

It is possible to change the destination of an action button or any hyperlink,
after creating it. This may be necessary for example if a web address (URL) or
a file location changes.

@ Manoeuvres

1.

On slide 7 right click on the CiA action button, (take care not to click on
the text content, you need to click part of the button itself).

Select Edit Hyperlink. The current hyperlink destination is shown.

To change the link to a different presentation, click the Hyperlink to drop
down list.

@ Hyperlink to:
F:\Ecdl Adv\AM& PowerPoint 2007 Data\CIA Seminar.ppb| v |

g Custom Show... »
15lide. ..

URL...

Qther PowerPoint Presentation. .. IE
Other File. .. '
F:'Ecdl AdviAME PowerPoint 2007 Data\CIA Seminar.pptx ™

1

Click on Other PowerPoint Presentation.

Select the Holiday Choice presentation from the data files and click OK,
then OK again to accept Slide 1 as the destination of the link.

Click OK in the Action Settings dialog box.

View the slide show for this slide and when the text has loaded click the
button to view the linked presentation.

End both shows.

On slide 7 right click on the word Information.

& Edit Hyperlink...

Open Hyperlink
Copy Hyperlink

*% Remowve Hyperlink

E Notice there is an option here to Remove the hyperlinks from this text.

10. Select Edit Hyperlink.

continued over

PowerPoint 2010 75 © CiA Training Ltd 2010



Section 5 Slide Shows ECDL Advanced 2.0

11.
12.

Driving Lesson 40 - Continued

Highlight the text in the Address box and type www.ecdl.com. Click OK.

Run the show from slide 7. Click on the Information text. If a connection
exists your browser application will start and the ECDL home page will be
displayed.

& ECDL Foundation - Windows Internet Explorer [om]
o~
e Yt/ vwvnws.ccdl.com/ publizher/indexsp v| B ‘¢,| % | sing o -]
i Favorites | <4 ) Suggested Sites = & | Get More Add-ons ~
— . = — SN g »
|55 - P41 Google Mail - Inbox (57) - .. | &3 ECDL Foundation x| | B~ v [ M + Page~v Safety~ Took~ @@~
Choose language:  English Espafiol Francais ohg ik pycckuit Site Search. | Enter search term | Go e
L
E;f:"aaﬁon ECDL/ C0L in your country.| Choose a Country / Territory [=] Geo

About ECDL Foundation Programmes | News Sitemap Contactus

For Individuals | For Employers | For Teachers & Students | Building the Information Society

m

¥
l 1
Who we are... Programmes Find a programme in your location
ECDL Foundation is the certifying authority of the ECDL Foundation has a range of ICT certifications ECDL /ICDL is delivered in 148
leading international computer skills cerification which cover introductory-level skills through to countriesiterritories through a network of nationally | 4
programme —ECDL / ICDL. advanced-level skills and professional-evel skills appointed partners (‘operators’). Each operatoris
. respansible forimplementing the programmes on
We support the continuous development of ICT What skills are you interested in?... 2 national level
skills through the use of structured training and
certification programmes. Read more about us Computers for Beginners [x] & For more information about ECOL / ICDL in
your area, please choose aregion from the options
News Press Coverage RSS Feed ] below and follow the links to your country page:
) Choose your region:
ECDL Foundation Forum 2009 - Press Release BCS Wielcomes Government Scheme To Get Low
Read more Income Families Online Africa
Done & Intemet | Protected Mode: On

|

A ER AL

E The appearance of the web page was correct at time of writing. It may change
over time.

13.
14.
15.

16.
17.

Close the browser window and end the slide show.
On slide 7, right click on the CiA button and select Remove Hyperlink.

Run the show from slide 7. Click on the CiA button text. The button no
longer contains a hyperlink and there will be no action.

End the show.

Close the presentation without saving.
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Driving Lesson 41 - Custom Shows

M Park and Read

Custom shows allow different parts of one presentation to be shown as different
shows to different audiences without the need for creating multiple versions of
the same presentation. For example, an audience of salespeople could see a
presentation without seeing those slides relating to administration and training,
and finance staff could be given the same presentation, but without the sales
and training slides. A custom show can be set up so that certain slides can be
missed out when necessary.

@ Manoeuvres

1.
2.

Open the Business presentation.

On the Insert tab, select Header & Footer, check the box to ;

include Slide number and click Apply to All. Header
& Footer

Save the presentation as Custom.

The presentation is to be shown to two departments of the same
company: Finance and Marketing. To avoid the creation of two separate
presentations, two custom shows are to be created, each showing a
different selection of slides.

On the Slide Show tab, select Custom Slide Show then Custom Shows
to display the Custom Shows dialog box. Click the New button to open
the Define Custom Show dialog box.

Name the custom show Finance as this is the show to be given to that
department.

Define Custom Show @

Slide show name: | Finance

Slides in presentation: Slides in custom shaow:

1. CiA Training

2, Mission Statement

3. Competition

4. The Team

5. Market Summary

6. Opportunities

7. Business Concept

8. Goals and Objectives
9, Finandial Plan

10. Resource Requirements
11. Risks and Rewards
12. Key Issues

Cancel

continued over
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Driving Lesson 41 - Continued

7. The Finance people do not need to see all of the Marketing slides. Select
the first slide, then click Add.
8. Select slide 2 and then hold down <Ctrl> as you select slides 4, 9, 11 and
12. Click Add to add them to the custom show.
Define Custom Show @@
Slide show name: | Finance
Slides in presentation: Slides in custom show:
_1. CiA Training 1. CiA Training
:2, Mission Statement 2. Mission Statement
3. Competition 3, The Team
4, The Team 4, Fi_nancial Plar.l.
S Opporantes | o] |5 s o revorcs Lo
7. Business Concept =
8. Goals and Objectives EEEIROVE hd
9. Finandial Flan
10, Resource Requirements
11. Risks and Rewards
12, Key Issues
[ 0K ] | Cancel
9. Click OK to return to the Custom Shows dialog box.
10. Create another custom show called Marketing (slides 1, 2, 3, 4, 6, 7 and
12). Click OK.
11. To edit the Marketing department’'s show, select Marketing from the list
in the Custom Shows dialog box and click Edit.
12. Click on slide 6 Business Concept at the right of the dialog box.

Define Custom Show @
Slide show name: | Marketing
Slides in presentation: Slides in custom show:
1, CiA Training 1, CiA Training
2. Mission Statement 2. Mission Statement
3. Competition 3. Competition
4, The Team 4, The Team
5. Market Summary 5. Opportunities EI
6. Opportunities ‘6. Business Concept
7. Business Concept 7. Key Issues
3. Goals and Objectives Remove IE
3. Financial Plan
10, Resource Requirements
11, Risks and Rewards
12, Key Issues

13. Click Remove.

Slide 4 The Team is to be moved after Opportunities. Select slide 4 from

14.

the right of the dialog box.
15. Click Move Down, .
16. Click OK and then Close.
17.
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Driving Lesson 42 - Running a Custom Show

M Park and Read

After custom shows have been created they can be run via the Ribbon, or more
professionally by adding action buttons to the presentation.

@ Manoeuvres

1.

9.

View slide 1 of the Custom presentation in Normal View, display the
Slide Show tab and click Custom Slide Show.

Finance

Marketing

_';T Custom Shows...

To run the Finance show, select it from the list.

Click the mouse to advance the slides, noting which slides are displayed,
and click to exit.

View the Marketing show in the same way.

To create a copy of the Marketing show, click Custom Slide Show and
select Custom Shows.

Select the Marketing show and click Copy.

The new show Copy of Marketing appears below the others. Click on it
and select Edit.

Change the name to Directors and click OK.

[ Customn Shows @ﬁ

Custom shows:

Finance
Marketing
Directors

I Close ] I Show

A copy is not actually needed. Select Directors and click Remove. Close
the Custom Shows dialog box.

continued over
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10.

11.

12.
13.

14.

15.

16.

17.

18.

19.

Driving Lesson 42 - Continued

It would be better to select the required show by using action buttons on
the first slide. Insert an Action Button:Custom at the lower left of slide 1.

Select Hyperlink to and from the list select Custom Show | Finance
then click OK and OK again.

With the button selected type in Finance. Click away from the button.

Repeat the above steps to create a button for the Marketing custom show
at the right of the first button.

Resize and move the buttons as necessary.

Because slide 1 will now always be displayed in order to start the custom
shows, you may want to remove it from each show sequence. To remove
slide 1, click Custom Slide Show, and select Custom Shows.

Select the Finance show and click the Edit button.

Select slide 1 from the list on the right and click Remove. Click OK.
Repeat these steps for the Marketing show and close the dialog box.

Run the full slide show, 12 slides will be displayed. Start the show again
and use the Finance button to see the shortened custom show,
advancing by clicking. This is easier than using the Ribbon. Notice the
slide numbers at the bottom right of the slides.

Save the presentation and leave it open.
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Driving Lesson 43 - Applying Transitions

M Park and Read

To add interest to a slide show, a transition can be applied to slides. This is a
special effect, which controls how one slide changes to the next. Timings can
be applied to the effects, so that they appear after a specified interval, or they
can be displayed manually by clicking the mouse.

@ Manoeuvres

In Slide Sorter View, select slide 1.

To create a transition effect, display the Transitions tab, and click the
More arrow in the Transitions gallery.

Home Insert Design Transitions Animations Slide Show Review View

O = =5 F @ @ -
ut Pu Wipe eveal

Mone C Fade Push Split Reveal =1

More

3. Select any effect from the list of transition effects shown. A demonstration
of the effect is shown.

4. Try using some of the other effects to see what they do, then =
select Dissolve. s

Dissaolve

5. Change the Duration to 4 seconds using the up spinner,
located in the Timing group.

6. In Advance Slide options, select On Mouse Click, then click Apply To
All. All slides now have the Dissolve transition effect applied.

E Each slide can have a different effect if desired, although normally they would
all be the same. To apply an individual effect, select the slide, choose an effect
from the Transition to this Slide Group, but do not click Apply to All.

7. Select the first slide, then view the slide show. Click the mouse button to
move through all the slides and notice the effects as the slides change.

E A slide that has a transition applied has a symbol underneath it in Slide
Sorter view.

8. To apply timings to the transition effects select slide 1.

9. At the moment slide transitions do not start until the mouse is clicked.
Select the Transitions tab. Under Advance Slide, remove the check
from On Mouse Click, then check After.

continued over
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ECDL Advanced 2.0

Driving Lesson 43 - Continued

10. Use the up spinner to increase the time to 5 seconds:

Advance Slide
[ on Mouse Click
After: 00:05.00 &

-

11. Click Apply to All. In Slide Sorter View, the transition timing for each
slide is now shown underneath the slide image.

The Team

« List CEQ and key management by name.

« Include previcus accomplishments to show
that these are people with a record of
SUCCESS.

- Summarize number of years of experiencein
this field.

e

5y 00205

4

Market Summary

» Summarize your market in the past, present,
and future.
* Ravigw thosa changas in markat shara, lkeadarship,
playars, markat shifts, costs, pricing, or
com patition that provida tha opportenity for pour
Company's SUCoass.

o

5y 00:05 5

12. View the slide show. The slides advance every 5 seconds without the
need for clicking. Using this option the slide show could be left to run
without the need for a presenter, as a continuously running display for

example.

13. When the show ends, remove the check from After and select On Mouse
Click again. Click Apply To All. This has removed the transition timings.

E It is possible to select both Advance Slide options (mouse click and automatic)
at the same time. Then each transition can be activated by using the mouse if
required, but if this is not used within the set time, the transition will start

automatically.

14. Save the presentation and leave it open for the next exercise.
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Driving Lesson 44 - Applying Timings

M Park and Read

Instead of applying timings to slide transitions, slide shows can also have
timings applied to each slide separately. This means that enough time can be
allowed to describe each particular slide. These timings are set up during a
Rehearsal.

E If a presentation contains hyperlinks and action buttons it should be run
manually, so that the links can be used.

@ Manoeuvres

1. In Slide Sorter View, select the first slide. To apply timings select Slide
Show tab and select Rehearse Timings from the Set Up group.

2.  The slide show begins, with the Rehearsal dialog box on the screen.

X
S 0 0:00:03 S 0:00:03

3. Allow enough time to talk about the slide then click the Next button, [#],
The next screen appears with the time for the current slide reset to zero.

4. Pause the rehearsal by clicking [, then restart it by using the Resume
Recording button. Move to the next slide/effect.

5. View the entire presentation, clicking the Next button after the required
time period for each slide until finished.

6. Atthe end of the rehearsal a dialog box appears showing the total time for
the slide show and asking if the timings are to be saved for future use.

Microsoft PowerPoint

. | The total time for the slide show was 0:02: 16, Do you want to keep the new slide timings to use when you view the
slide show?

| Yes | | e J

7. Click Yes. The individual times for each slide are now displayed. The total
time for the slide show is made up of these times. The timings can be
changed at any time by clicking the Rehearse Timings button again.

8. Individual timings can still be amended. Click on slide 3. In the
Transitions tab, increase the Advance slide time value by 5 seconds.

9. Save the presentation and leave it open.
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Driving Lesson 45 - Setting up a Slide Show

M Park and Read

A slide show can be set up to run in a few different ways. It can be run
manually, by clicking the mouse, or automatically using timings. It can also be
set up to loop, running continuously. Note that even when timings have been
applied to a show, you should check to make sure that it has been set up to use
these timings.

@ Manoeuvres

1.

To make sure the timings specified earlier are to be used when the show
runs, display the Slide Show tab and select Set Up Slide Show.

In the Set Up Show dialog box under Advance slides, select the option
Using timings, if present.

Set Up Show 7| 3]
Show type Shaow slides
@ Presented by a speaker (full screen) @ all
Browsed by an individual (window) From: || = Ta: =
Browsed at a kiosk (full screen) Flskm =how:
Finance IE'

Show options

[ Loop continuously untl ‘Esc’

[T show without narration

[ show without animation

= I - |
Laser pointer color: I IZ‘

To show a laser pointer during slide show, hold down the Cirl key and press the left mouse

button.

Advance slides

Manually
@) Using timinas, if present

Multiple maonitors

Primary Monitor

Show Presenter View

[ Ok ] [ Cancel |
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Click OK, then save the presentation. View the slide show, which will now
play using the timings set in the rehearsal. There is no need to click the
mouse.

Select the Slide Show tab and select Set Up Slide Show.
To disable the timings, select Manually under Advance slides. Click OK.

Click on the first slide and then view the show.

continued over
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10.

11.
12.

13.
14.

15.
16.
17.
18.

19.

20.
21.

22.
23.

24.

Driving Lesson 45 - Continued

The first slide in the presentation appears. Click the mouse to move to the
second slide.

Move through the rest of the slide show.

At the end of the show change the set up within the Set Up Show dialog
box to use timings again, but don’t click OK yet (the show could still be
advanced using the mouse if desired).

To make the show run continuously, check Loop continuously until
‘Esc’.

Show options

¥|Loop continuously until 'Esc

Show without narration

Show without animation

Click OK.

View the slide show again and when the end is reached, the show will
start again.

Press <Esc> to end the slide show.

To stop the show looping, select Set Up Slide Show from the Slide
Show tab and uncheck Loop continuously....

Click OK.
Save and close the presentation.
Open the presentation Holiday Choice.

Select the graphic on slide 1 and apply an Entrance Animation effect of
Fly In.

Set Direction to From Left and use the Timing option so that it starts
after the previous event with a delay of 3 seconds.

View the show for this slide only.

The show can also be run without animation. Select the Slide Show tab
and click Set Up Slide Show button.

Under Show options, check Show without animation and click OK.

View the show for this slide again and notice how the picture is not
animated.

Close the presentation without saving.
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Driving Lesson 46 - Slide Show Techniques

M Park and Read

While running a show, you may need to pause to expand on a particular point,
or indicate areas on a slide. There are various ways of controlling the show and
being able to do just that.

Manoeuvres

1. Open the presentation Theatre.

2. Display the Slide Show tab and start the slide show. Click to move to
slide 2. Right click on the screen to display a menu of options.

Some of these options are also available as buttons (almost hidden) in the
lower left corner of the screen.

3. From the shortcut menu, select Pointer Options | Pen. You are going to
annotate the slide.

4. Click and drag to draw a line beneath newly refurbished. This method
could be used to emphasise a point as the show is presented.

5. Right click and select Pointer Options | Eraser. Click with the eraser on
the line to remove the pen mark.

6. Right click and select Pointer Options | Arrow, then click to advance to
slide 3. Slides will only advance when the Arrow option is active.

7. At this point, you may wish to pause for questions. So there are no
distractions, right click and select Screen | Black Screen. Right click and
select Screen | White Screen for a different effect.

In some versions of PowerPoint, White Screen is not available.

8. Click to resume the show. To end the show at any time either press
<Esc> or right click and select End Show.

9. Apply a transition effect of your choice to all slides, with automatic timing
of 5 seconds.

10. When timings are applied the show can be paused during its progress.
Start the slide show and let it continue to slide 3.

11. Right click and select Pause to pause the show.

12. Right click again and select Resume to start it again. Let the show
continue to the end and the click to exit.

13. Close the presentation without saving.
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Driving Lesson 47 - Revision

This is not an ECDL test. Testing may only be carried out through certified
ECDL test centres. This covers the features introduced in this section. Try not to
refer to the preceding Driving Lessons while completing it.

1.
2.

10.

Open the Kittens presentation.

Create a custom show called Information consisting of slides 3, 4, 5 and
8.

Create a second custom show called Charity consisting of slides 2, 6 and
7.

Create an action button for each custom show on slide 1, one at the
bottom left of the slide and one at the bottom right.

View the slide show from slide 1 and use the action buttons to view each
custom show in turn.

Use the Pen option to draw on slide 2 in the Charity custom show -
underline How to make a donation.

Change back to the Arrow pointer option.
Pause the show by displaying a black screen, then restart it.

End the slide show. A message will ask if you want to keep your ink
annotations, click Discard.

Save the presentation as Shelter and close it.

If you experienced any difficulty completing this Revision refer back to the
Driving Lessons in this section. Then redo the Revision.
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Driving Lesson 48 - Revision

This is not an ECDL test. Testing may only be carried out through certified
ECDL test centres. This covers the features introduced in this section. Try not to
refer to the preceding Driving Lessons while completing it.

1.
2.

10.

11.
12.
13.
14.

Open the presentation CIA Seminar.
Apply a Cover slide transition to all slides.

All transitions should be advanced automatically after 5 seconds, but
also leave the On Mouse Click option selected.

Set the Transition Duration to 4 seconds.
Set up the show to use timings and to loop continuously.

View the slide show. Use the mouse button on a few slides to override the
timings and display a black screen while viewing slide 3.

Continue the show.
After it starts for the second time press <Esc>.
Remove the option to loop continuously.

Rehearse timings for the show, advancing slide 1 after about 10 seconds
and all others after about 15 seconds.

Keep the timings.
Save the presentation as Seminar Complete.
View the slide show again.

Close the presentation.

If you experienced any difficulty completing this Revision refer back to the
Driving Lessons in this section. Then redo the Revision.

Once you are confident with the features, complete the Record of Achievement
Matrix referring to the section at the end of the guide.
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